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1. Plan documents 
1.1 - Determine the purposes of documents 
 

On 1 January, 2012, the Work Health and Safety Act became harmonised so that the legislation, 
regulations and codes of practice will be consistent across States and Territory.  For the purposes of 
using safe work practices, you should understand your duty of care in regards to using technology in a 
work environment. 

As a worker you are required to ensure that your worksite is safe and free from hazards and risks.  If you 
see a hazard or risk you must report it to your employer.  If you do 
not report a risk or hazard you may be held liable under law if anyone 
is injured.  Your employer has a duty to you, the worker, to correct 
any risks and hazards on the worksite.  If you are injured; your 
employer can be held liable for negligence. 

No environment is free from danger no matter how much the 
organisation plans. 

If are not familiar with your organisation’s policies and procedure 
regarding safe work procedures in using technology then you should 
access and read the information.  

 Other information that you should read includes: 

 The equipment operating guidelines; and/or 

 The manufacturers’ manual. 

Basic safety standards that you need to follow include: 

 Allowing no moisture to fall near electrical equipment and leads 

 Ensuring that the equipment is well ventilated 

 Keeping metal objects like paper clips away from equipment 

 Maintaining equipment. 

Consult your supervisor or colleagues or manufacturers manual if you have any problem understanding 
any of your work place procedures in regards to the operations of the technology. 

If you identify a hazard in your work area, report it. 
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Before you start work, inspect your work area 

 There are not too many plugs connected to power points. 

 That lighting is safe and hazard free by ensuring that 

o Light does not reflect off computer screens 

o Lights do not flicker 

o Shadows and reflections do not bounce off the 
computer screen   

Each of these will interfere with your ability to read the computer screen. 

Other safety issues that you should be aware of are: 

 If you find that equipment is loud, put the noisy equipment in another area that will 
ensure that the noise does not interfere with work output. 

 If your computer terminal does not have a radiation screen, order one to put over the 
computer screen to minimise exposure to radiation.  

 If you sit for long periods of time in front of a computer, sit 50 centimetres away from 
the screen. 

 Make sure that the air conditioning or heating is not too hot or cold.   Temperatures 
should be between 21 to 24 degrees Celsius.  If the temperatures vary too much it can 
harm your health and safety. 

Ergonomics 
Ergonomics is the relationship between the tools of doing your job and the people using the tools.  The 
tools of any job must be appropriate for the job.  In an office environment, to decrease the chance of 
risk; chairs, tables and desks need to be adjustable.   

If you cannot adjust your furniture you can do the following damage: 

 If you sit incorrectly, you can suffer musculature damage.   

 If you do too many repetitive tasks you could end up with RSI.   

 Fatigue can be caused by eye stress.   

 These problems are addressed through the control and use of the workstation design. 

Dohrmann and Associates in Ergonomics in Australia have made the following recommendations in 
regards to minimise the chances of discomfort and stress in the workplace.   
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Chair 
 Posture is a very important part of your workstation design.  This is why you need to 

make sure that you choose the correct chair to work from. 

 Your chair should always be on a 100 – 110 degree angle.  Have an active back 
mechanism and adjustable armrests so that you can change your position frequently. 

 

 

 

 

 

 

 

 

 

Keyboard 
Your keyboard is in the correct position. The correct position will allow you to: 

 Bend elbows at a 100 -110 degree angle.   

 Sit upright and tilt your keyboard away from you at a negative angle.   

 If you are using a wrist rest, only use it when you are typing.  Do not rest your hands on 
the rests if you are not typing.   

 Do not place your wrist rest higher than your keyboard space bar. 

 

 

 

100° 
to 
110° 
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Workstation – Avoid Overreaching 
 Keep your work close to you at all 

times.   

 If you look at your document holder as 
much as you look at the screen, place 
the screen in front of you and the 
document holder slightly to the side.  
Adjust positions until you are 
comfortable. 

 If you have books or paperwork on 
shelves or in files, do not reach for 
them.  Stand up and walk to pick them 
up. 

Take a break to minimise eye fatigue 
A short 1 -2 minute break every 20 -30 minutes will help you to minimise eye fatigue.  If necessary, 
change tasks every five to ten minutes.  Use the correct posture and move every 5-10 minutes. 

Good posture will reduce the occurrence of strain and fatigue.  To maintain good posture: 

 Always centre your monitor. 

 The top of the monitor should be around 2-3 
inches above seated eye level. 

 Sit arm distance from the screen and adjust the 
distance from your screen. 

 If you get a glare, adjust computer screen, 
partially close curtains and keep glare to a 
minimum level. 

 Keep your head upright and balanced 

 Avoid pressure to the front of your seat 

 Keep shoulders relaxed 

 Make sure that feet are firmly supported. 
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Adjust Furniture 
To minimise the chances of OOS adjust your furniture.  For example, make sure that your chair can be 
adjusted so that your elbow tips are even with the ASDF keys, that your desk is adjustable and gives you 
lumbar support.   

Overuse Syndrome 
Occupational Overuse Syndrome (OOS) is also known as Repetitive Strain Injury (RSI).  In the 1980s, OOS 
cost organisations millions of dollars.  Computers were new to the workforce and Australia was 
uneducated about the damage that OOS could do to the body. OOS has a range of conditions.  It can 
affect muscles, tendons, back, shoulder, neck, wrists, fingers and hands leading to persistent pain and 
discomfort. 

To prevent OOS you should: 

 Avoid all risks in the workplace 

 Avoid stretching 

 Maintain comfortable grip on all hand tools 

 Use ergonomically designed furniture e.g. mouse, keyboard 

 Vary your work load throughout the day 

If you work in an occupation that consists of many repetitive tasks, then you 
need to make sure that you take breaks and vary your tasks.  OOS can affect 
your ability to work, so it is important to make sure that you follow the steps 
outlined in the first part of this manual. 

Conservation 
Conservation of the planets resources has led to many nations in the United Nations to signing a 
conservation pact.  Part of Australia’s contribution to the conservation of the planets’s natural resources 
is to create awareness about the environment.  To minimise costs to the environmental and to conserve 
energy, many organisations are changing the way in which they use paper. 

To minimise cost to the environment, organisations: 

 Store email messages in folders on their computers rather than printing them 

 Recycle paper and toner cartridges. 

 Reuse paper 

 Print both sides of the paper 

 Print only the copies you need. 
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To conserve energy, organisations: 

 Use the ‘power save’ option on equipment 

 Switch of lights when no one is in the area 

We live in an age of information.  Everywhere you look there is 
information and knowledge at your fingertips.  As the pace of 
technological innovation increases, more and more demands 
on our time will be required, as we are living in a dynamic and 
forever evolving time period.  Globalisation has opened many 
more business opportunities for organisations.  To meet the 
growing demands there has been increases in legislative and 
regulative requirements for most industries. 

As a leader, you will be required to report more and more 
information to management as the demands of change impact further on your job role.  The purposes of 
documents that you may be required to write may include: 

 Conveying research findings  

Conveying research findings so personnel will understand, believe and act upon them.  
Take the time to convey information without being boring.   Be clear on what you are 
delivering. 

Make sure that you are aware of your audience and when they require the information.  
The information that you provide them should be tailored to the needs and interests of 
the audience.  Try to make it brief and succinct.  Stick to the details.  No one wants to 
read information if it does not relate to their needs. 

The detail provided in your research will determine the detail and how formal you 
should be on your deliverable. When you provide information, it is important to 
communicate your findings and remain with the facts.   

 Documenting policies, procedures and processes 

Every time there is a change within the work place, there needs to be a correlating 
update of policies, procedures and processes that must be communicated to personnel. 
Organisations have a legal obligation to consult with workers and anyone impacted or 
influenced by a change.  Even though this process relates to hazards, many changes will 
usually require a review as every time a change occurs in the workplace there is the 
potential that a hazard may arise due to the change. 

Updating policies and procedures will vary from organisation to organisation.  As such, 
if you are not already familiar with the process in your workplace, you should take the 
time to learn the correct procedures.   As documentation is updated, it needs to be 
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communicated to personnel as you will be sharing critical information as it is 
developed.  Once the information is documented, the information must be shared, not 
only as a requirement of work health and safety law, but to ensure that personnel can 
make informed decisions. 

Documenting processes helps in creating systematic information to develop a flow of 
information and helps to identify where updates in procedures will impact on the 
organisation. 

 Influencing attitudes, opinions, beliefs 

Attitudes have a big impact on beliefs.  Attitudes form 
how we evaluate things and form opinions.  Attitudes 
influence how we feel, how we think and influences our 
behaviour.  Attitudes are formed as a direct result of 
personal experience.  Researchers have demonstrated 
that attitudes influence behaviour through: 

o Personal experience 

o Knowledge of a subject 

o Expecting a favourable outcome 

o Making sure that the subject is repeatedly 
expressed; and 

o Parties stand to win or lose due to the issue. 

When you communicate with parties, it is essential to ensure that you communicate in 
a manner that aligns with their attitude.  Give people facts and figures, cause and 
effect, to influence their attitudes.  Attitudes are easier to change than beliefs and 
opinions.  Take the time to make sure that parties know what is in it for them. 

 Meeting legal requirements 

Environmental scanning is the process of scanning the environment, political, legal, 
economic, technological and social environment for changes.  The legal environment 
will provide you with updates in ensuring that your legal requirements are met.  
Employer or industry association membership will ensure that you will be kept up to 
date on changes to the legal environment and how the organisation can change its 
policies and procedures in regards to changes to legislation and the impact the change 
will have on the industry. 
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For changes in Work Health and Safety Legislation, you can access Safe Work Australia 
and entering your email on the website and subscribe to updates at URL Address: 
http://www.safeworkaustralia.gov.au/Pages/default.aspx Access Date: 20.02.2012 

 Meeting other data, information or knowledge needs of an audience 

No matter how in touch you are with the needs of the audience, you never know 
exactly how people will see it.  The best way in which to meet the needs of your 
audience is to test it to make sure that the 
leaders within the group understand 
what you are trying to convey.  If other 
leaders support your recommendations, 
you will find that they are likely to 
influence each other in a group setting. 

For this reason, work group meetings are 
an excellent way in which to convey 
information to workers.  Meetings give 
workers and management a forum in 
which to discuss information, data and 
provide knowledge.  It is only when there is 
one real option that is viable that you influence the audience.   

Workers must feel that they are part of the decision making process.  However, you 
should always stick to facts.  Personnel must see the idea as their own idea.  The more 
facts that you give them, the more they will have to reflect on.  Make sure that you 
reinforce each point to let them know what is in it for them. 

 Proposing recommendations, options and actions 

Proposing recommendation, options and actions provides management with a choice.  
Make sure that both the positive and negative aspects of the problem are considered.  
It is important that the writer is objective in every instance.  These documents are 
updated and recorded.   

Make sure that you stay focused on the organisational requirements and legislative requirements when 
you write a document.  If you do not, then you may miss important information.  To maintain the 
respect of personnel, you need to make sure that you maintain credibility.  This means that you need to 
consider all of the contingencies that will impact on the way you write your document.  

http://www.safeworkaustralia.gov.au/Pages/default.aspx
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1.2 - Choose appropriate formats for documents 
 

The format of information is guided by organisational policies and procedures.  Legislative and 
regulative requirements will influence the way in which you present information.  Organisations will 
have a set format that they follow.  To ensure that the formatting in a document is consistent, a 
template of the documents that are produced should be easily accessible in 
your software. 

Note that the following information provides you with examples of different 
formats.  Formats for different templates may be found in your software 
programs (see Appendix Number Two).  You will find that there are 
different formats for different information.  If you are not sure about the 
format required for a specific document, ask a member of your work group.  
If there are no standardised templates, access files to see how a specific 
report was presented originally and follow its formatting structure. 

Appropriate formats for documents may include: 

Emails (Appendix One) 

To open electronic mail, you must go to  

   Start- All Program-Microsoft Office-Microsoft-Office Outlook 

Most organisations use Microsoft Office now, however, it is important to read your organisations 
policies and procedures to make sure that you are using the correct program. 

Every email that you send has a several sections.  If you are not already familiar with these sections, 
then you should ask for assistance. 

Detailed business letters (Appendix Two) 

A normal part of your day will include being exposed to different types of letters.  Whilst the style and 
format of the letters will vary, the same general rules shall apply. 

When you write a letter, it is important to keep your style more formal than the way you normally 
speak.  The layout should be clear and have all of the information set out. 

  



P a g e  | 14 
 

Instructions and procedures 
Instructions are the steps required to complete a task or a series of 
tasks.  The audience is usually someone who does not have the 
ability to perform a task. Procedures are a special type of instruction, 
usually for personnel who are familiar with a task.  Procedures 
ensure that all work group members coordinate their activities when 
reviewing a task.   

Instructions and procedures are written and designed for several 
different formats from brochures to printed material in PDFs from 
the internet to CDs that arrive with a product.  The format used 
should correlate with the audience. 

Instruction and procedure formats may include: 

 Instructional brochures that are posted, mailed or 
handed out to a broad audience 

 User manuals 

 Quick reference materials  such as a web page or 
wallet sized card 

 Hyperlinks to online instructions that allow users to 
read different layers of information 

 Computer instructions that can be found within your software.  Access these 

instructions in Microsoft Office 2010, click once on the  on the upper right hand 
corner of your screen and the task pane showed above will open. 

Manuals 
Manuals have a tendency to be more comprehensive then instructions and contain information about 
using products, along with descriptions and specifications, legal warnings on how to use the product 
safely and troubleshooting advice on the operations of a product or how to perform a task.  
Instructional manuals such as this learner guide should be easy to follow and understand.  It can also be 
used as a reference document when learning is complete. 
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Legal or traditional requirements for the particular document format 
Legal documents such as forms for taxation and other government bodies are standardised.  Failure to 
complete the appropriate form with the appropriate boxes answered can lead to rejection of a form.  
Operating manuals and manufacturers manuals such as safety data sheets used for chemicals clearly 
outline your requirements as part of the law.  For example, the Preparation of Safety Data Sheets for 
Hazardous Chemicals code of practice is a requirement of the WHS Act, 2011. 

Other legal requirements may include: 

The Privacy Act 1988 contains the National Privacy Principles that cover 
Confidentiality requirements in the workplace.  These principles apply 
to: 

 Personal information – information or an opinion 
(including information or an opinion forming part of a 
database), whether true or not, and whether recorded 
in a material form or not, about an individual whose 
identity is apparent, or can reasonably be ascertained, 
from the information or opinion. 

 Sensitive information – personal information about an 
individual’s records, including racial or ethnic origin, 
political opinion, membership of a political association, 
religious beliefs, health status and memberships. 

Section 271 of the WHS Act, states that “if a person obtains information or gains access to a document 
in exercising any power or function under the Act.” 

If a person obtains access to confidential information they must not disclose any information or the 
content of the document.  This also means that if you are given access to a document, you must not give 
anyone else access to the document or use the information or document for any other purpose.  If you 
obtain access to the information or use the information in the document, you cannot disclose the 
information without the person’s consent; or perform your power or function under the WHS Act. 

When gathering information under Anti-discrimination it is essential that you understand the two 
different Acts that Anti-discrimination is covered within.  Anti-discrimination refers to law that ensures 
that all people in Australia are treated equally. 

 Discrimination can relate discrimination relating to age, sex, marital status, and religion, 
political and cultural beliefs. This is covered under the Discrimination Act 1991.    

 Under WHS law (S105) relates to discriminatory conduct through the dismissal of a 
worker or termination of a contract or alters a worker’s position to their detriment, or if 
personnel are refused a position and are treated them less favourably than others, then 
the employer can be found to be discriminating against the potential or current worker. 
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Each type of discrimination is illegal and you can be fined if found guilty of breaching these laws.  Care 
should be taken to ensure that you also do not discriminate when using words.  For example, using sales 
woman, instead of sales person or stereotyping personnel based on the cultural background. 

Organisational policy, procedures and guidelines applying to writing documents, 
including house style 
Consistency of structure will be reflected in the: 

 Company logo - Logos are a statement of the 
organisations image.  When a customer receives 
mail from an organisation, they will set it aside as 
it will distinguish itself from other mail. 

 Company colour scheme 

o Bright primary colours grab a child’s eye. 
These dominant colours in a reception area 
are not conducive to increased 
productivity. 

o Pastels and light colours are conducive to 
increased productivity and the organisation 
must reflect this consistency by using more 
sedate colours on the logo. 

 Document production - Formatting includes the font, page setting and style of text.  
This also includes paper size and the type of paper used.  For example, no 
communication will occur without the use of a logo, colour scheme and formatting. 

 Content restrictions - The restriction of content has been incorporated into many 
organisation’s policies and procedures.  This will usually include not using 
organisational documents such as emails and letters for personal reasons and for 
sending specific emails.  If you are not sure about content, ask for assistance. 

 Templates - Templates can be found in software.  Organisational personnel can develop 
their own templates to suit their needs and ensure that consistency will automatically 
run across all of their products.  These templates and other “house style templates” 
(which are required in certain circumstances such as to complete forms) can be found 
in computers and associated software programs. 
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When you refer to a style, you are referring to the presentation of the document that you are 
developing.  The style includes: 

 The headings that you must use in the document 

 The font, type size of text 

 Whether text and/or information should be bold, italics or underlined 

 Colour of text, bullets and structure of the paragraphs. 

Organisational policies and procedures may include:  

Paper White    

 9 inches by 11 inches    

 One side only  

Title Centre near the top    

 ALL CAPS    

 Your name centred underneath the title    

 Name of team, supervisor and date 

Text 11 point standard font    

 1.5 space text body    

 Single space block quotes    

 One space following a period at the end of a sentence  

Margins 1 inch at top, bottom, and sides 

Paging  Page numbers in bottom middle 

Indentation Omit page number on title page and first page    

 Indent 5 spaces for each new paragraph  

Quotations Use quotation marks when quoting directly 

 

These format requirements may vary according to the type of organisation and the type of 
information you are trying to convey.  In most instances, organisations will have set procedures for 
different formats. 
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Point numbering systems 
Numbered lists should be used to ensure that the reader is able to follow the logical sequence of 
information or instruction.  Numbers also assist personnel in identifying where they left the instructions 
so they do not waste time doubling back. 

Publications, brochures and leaflets 
A publication is the process of publishing printed matter, such as brochures and leaflets. 

A leaflet is a hand bill or flier that is printed and is intended for free distribution. 

Brochures are one of the best ways in which to present a company.  A brochure has three main 
functions: 

 Advertising function – where the brochure is used as an advertising tool where one or 
more products is analysed 

 Identification function where the brochure allows you to maintain the same criterion 
with all of the organisations brochures.  This will make the companies brochures 
recognisable immediately. 

 Informative function that informs potential clients about your company, including its 
presentation, its products and services 

It is important to choose the correct format to determine the effectiveness of your brochure.  Some 
brochure format is chosen not only for the information presented, but also their structure.  Some 
brochure designs include: 

 Folder with flaps and inserts  

 Bi-fold brochures letter or A4 size 

 Leaflet or A4 size 

 Tri-fold A3 

 Bo-fold brochure A3 

The format of the brochure and its size must match the intention of your brochure.  For example you 
design a brochure to advertise a marketing event, while handing out loose leaf information from other 
vendors.  To assist in carrying the loose leaflets, you would use a folder with flaps and inserts. 
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Reports 
A standard format for report writing includes: 

Headings Outline 

1. Title The title of your document must reflect the report that you are 
completing.  Make sure that the title is short 

2. Table of Contents Should be on a separate page  

Should have listing of headings for each page 

Numerical figures are usually used to map the reports logical sequence 

3. Abstract 

       Exec Summary 

Write last  

Should summarise the essential points of the report, including 
conclusions and recommendations 

Should be clear and easy to understand so the reader can determine 
whether they should read all of it. 

4. Introduction Must draw in the reader 

Should explain why the report was written, any relevant information on 
the subject 

Should include the methods of evaluation or investigation. 

5. Body Headings must be clear and show body of report 

Body must correlate with headings 

Data collection methods should be included 

The findings of the report and discussion of findings drawn from the 
theory 

6. Conclusions Sum up the key points of the report 

Express opinions, but use points to support them 

Drawn from the discussion 

7. Recommendations Should suggest areas of improvement base on the conclusions 

Not all reports have recommendations so mention the 
recommendations if you add them. 

8. Bibliography Or otherwise called reference  

Lists all publications 

9. Appendix Shows information from the report that would interfere with the flow of 
information. 

 

Please note that all of the headings in bold must usually be part of the report.  The other options 
depend on the contents of the report and the requirements of the document. 
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Requirements for illustrations, photographs, graphs, charts, maps and other 
illustrative material to explain texts 
Visuals should be placed next to the step, if not straight after the step is written.  Make sure your visual 
is set in white space. It is important to make sure that your visual repeats and reinforces the words that 
you have used around visual. 

Use boxes to highlight instructions within a lot of white space to ensure that the box stands out. Use 

symbols , whilst CAPITAL and Bold text should be used as required. 

Speeches and presentations 
A speech or presentation has three parts.  They include: 

Parts What to discuss Percen
tage 

Introduction What the speech or presentation is about – present key points 
and emphasise main ones 

10% 

Body Explain what is happening - be clear – make sure link each part of 
the speech.  Illustrate main points with points to reinforce 
perceptions and present your arguments 

80% 

End or 
Summary 

Sum up the presentation or speech by using time to repeat and 
restate the summary.  Make sure that you language is consistent the 
whole way through. 

10% 

 

Standards for references 
All standards must be consistent.  When you start a specific reference, citation, footnote or 
acknowledgement for a report or document, it is essential that you maintain the same style 
throughout the report. 

Your organisation may have several different types of reference for different types of sources of 
information.  For example, in some instances the name of the Journal may be presented in Italics.  It all 
depends on the organisations procedures in regards to referencing. 

Electronic referencing from on line sources is presented: 

 

SafeWork Australia 

URL Address: http://safeworkaustralia.gov.au/Pages/default.aspx  

Access Date: 14.02.2012 

http://safeworkaustralia.gov.au/Pages/default.aspx
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Name of the website – Name of the author 

Use the name of the website.  If you reference a quote from a writer, you 
should reference the author’s name.  For example: Lloyd, P.   this author’s 
name is P. Lloyd.  Write the surname of the author and the first initial of 
their name. 

URL Address: 

The URL Address means (Uniform or Universal Resource Locator).  It is 
usually pronounced Earl.  The URL is the web address of the website.  For 
example; the URL Address for Safe Work Australia is 
http://safeworkaustralia.gov.au/Pages/default.aspx .  When you enter the 
URL Address on a document, the document will automatically underline the 
URL Address after you add a space when you type it in or cut and paste it. 

Access Date: 

The access date is important.  Web addresses are always being updated.  By providing the access date 
you are letting the reader of your information know that on this date, this information was current.  
When a file is moved or a website is renamed or becomes obsolete.  It provides evidence that on the 
date the internet was accessed, the website existed. 

Printed referencing of sources is presented: 

Journal (Please note that these references are samples only) 

Piper, P (2010) Alpha to Omega, Journal of Living Dangerously (55, 15) p.36 

Book 

Piper, P (2010) Management by Objectives, Andersons’ Ltd. United States of America p.45 

1. Author - The author is presented as a surname of the author and the initials for his 
first name. 

2. Date - The date is the date in which the issue of the journal and the book was 
printed. 

3. Article Date - The article name is the name of the article 

4. Journal Name - The name of the journal that the article has been drawn from is 
called the Journal Name. 

5. Series and Printed Number - Does the article belong to a series?  Many Journals 
will have a series number which will usually relate to the year of print.  The article 
may also have a print number or version number. 

6. Page Number - Make sure that you always include the page Number Using p. for 
page and the number of the page. 

7. Book - For books that you are using as resource material, follow steps 1- 4.  Step 4 
should be the name of the text.   

http://safeworkaustralia.gov.au/Pages/default.aspx
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8. Printer - Who printed the resource?  Make sure that you put the name of the 
printer so anyone reading your report can purchase or find a copy of the book.  In 
the book reference above Andersons’ Ltd is the name of the printer.   

9. Country printed in - Enter the country where the book was printed.  This makes it 
easier for personnel to find the resource.  In the case of the book reference, the 
reference shows that the book comes from the USA 

 

In the actual report, you site other authors as (Piper, 2010, p.36).  This reference, advises all readers that 
in 2010, Piper wrote an article or text and the quote that you have taken can be found on page 36.  If 
the author wants to read more about Piper, they refer to the References at the end of your report.  They 
can look at the references and find the appropriate reference. 

So what do you do if you cite a journal entry that has been downloaded off the internet? 

Your organisation may have different procedures in this case.  You should use both forms of referencing 
so that personnel will be able to access the information on line.   For example: 

SafeWork Australia 

Piper, P (2010) Alpha to Omega, Journal of Living Dangerously (55, 15) p.36  

URL Address: http://safeworkaustralia.gov.au/Pages/default.aspx  

Access Date: 14.02.2012 

 

For examples and explanations of different referencing styles go the The University of Queensland 
Australia – Referencing Styles at URL Address: http://www.library.uq.edu.au/infoskil/styles2.html  
24.02.2012 

  

http://safeworkaustralia.gov.au/Pages/default.aspx
http://www.library.uq.edu.au/infoskil/styles2.html
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Standards for footnotes 
Footnotes are used to provide references for articles.  Footnote markers are links to references ([1], [2]) 

  

To add a footnote on to a document, open your Word Document 

1. Right Click on References 

2. Move down to Footnotes 

3. Right Click on  

4. Add reference. 

Standards for citations 
If you cite a reference in a reference, you can write (Piper, citing Jefferies, 2010, p.36).  This means that 
you are citing Piper, who cited Jefferies. 

Samples of citations can be found in the Australian Guide to Legal Citation can be found at: 
http://www.mulr.law.unimelb.edu.au/files/aglcdl.pdf  Access Date: 23.02.2012. Note: These are 
citations for legal citations 

Standards for acknowledgements 
Acknowledgements are used when parties actively take a part of the development of your document.  
They may have assisted you or gave you information.  Acknowledgements can also be organisations and 
companies. 

  

http://en.wikipedia.org/wiki/Help:Footnotes#cite_dummy
http://en.wikipedia.org/wiki/Help:Footnotes#cite_dummy
http://www.mulr.law.unimelb.edu.au/files/aglcdl.pdf
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Time lines, including deadlines 
A time line can be used to set up the tasks that meet your deadlines.  They give you a visual of your 
priorities and can assist you in making sure that you complete your tasks on time. 

 

To assist you in developing your time line, you can create lists.  These are the basic rules that should be 
followed: 

 Create a list of what tasks you need to perform 

 Write down and follow-up items 

 Carry forward any task that is not completed 

 Keep track of any due dates 

 Create a list of priorities 

 Keep track of all of the tasks that are on-going 

 Make sure that your work area is clean so you do not lose vital information 

 Make sure that all of the current work is kept in the same location 

File information that is no longer required into a folder to be stored.  Delete any information that is not 
required. 
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Website text 
Internet information is a different form of information medium.  It is presented to you differently and it 
is important to know how you need to prepare web text so it can be absorbed.  When you develop web 
text, you should use: 

 Shorter sentences 

 Clear headings and sub headings 

 Use shorter paragraphs 

 Bullet lists 

 Highlight text that you want to emphasise. 

One way in which web page text can be formatted is through Block Tags.  To find out how to perform 
this task, go to URL Address: http://www.tubetorial.com/html-block-tags/ Access Date 23.02.2012. 

Word length 
People are inundated with information every day, all day.  Give details and references to support both 
side of the argument.  Provide short definitions of information.  If you babble on, they will lose interest 
and not pay attention to the document as they should.   

Writing styles, including simplicity of English and use of technical language 
Readability is important when you develop documents.  For a document to be readable: 

 Use a direct voice, be active and make sure the wording is clear 

o Emphasise the role of the user, write as a second person  

o Begin all steps and sub steps as verbs, using active voice and a positive command 

This opposed                                                       To that 

Enter access code                                               You need to enter the 

access code 

 

  

http://www.tubetorial.com/html-block-tags/
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 Use positive phrasing 

o Avoid too much negative phrasing 

This opposed                                                      To that 

Check your electrical cord for          Ensure that electrical cords  do not         

exposed wires                                                    have exposed wires 

 

 Use transitions 

o Use transitional expression to allow for bridging similar ideas 

For example 

First, check the electrical cord and then turn on machine 

 

 Use logically shaped and short questions 

o One sentence for each step.  If one step covers two actions, make sure the 
actions or in the correct order 

The correct way 

Turn computer on, enter password 

 

 Use parallelism 

o Used to provide step to step instructions in a logical order 

To turn on the computer: 

1. Check electrical cord for safety 

2. Press “on” button 

3. Type User Name and Password in “Logon”  

4. Press Enter 
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All business documents should be clear and concise.  Writing business documents means that you 
need to know: 

 The purpose and scope of your document 

 Understand the needs of your audience and write the document according to their 
needs. 

 The format and sequence of your document 

 Get to the point immediately 

 Get active and use fewer words 

 Avoid the use of jargon unless you provide definitions 

 Be clear  

 Be objective 

 Be concise 

 Proofread for grammar and spelling errors 

 Write conclusions and recommendations using supporting material. 

1.3 - Establish means of communication 
 

Once you have established who you need to communicate to, the way to communicate and how you are 
going to gain the attention of the personnel, you will need to determine the means of communication.  
Which software package would you use? 

When you communicate, you need to consider the most appropriate package that will meet your needs. 
Listed below are three packages common to most organisations.  By knowing what software options 
there are available and what each package will allow you to do, you will be able to choose the package 
that will afford you the most productivity. 

Software packages as a means of communication may include: 

Software What you can do with the software 

Spread sheets 

 

 

Spread sheets are an excellent way in which to make tables.  Using 
columns and rows, you will be able to form graphs, set out data so it is 
easy to read and make calculations.  Spread sheets are usually used in 
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Software What you can do with the software 

business to calculate figures for: 

 Cost analysis 

 Sales  

 Budgeting 

The spread sheet package can perform any task that requires the use 
of numbers and calculations. 

Word processing 

 

 

Most word processing programs give the functionality of increasing 
your productivity. Some of the options that you will find in most word 
processing programs are: 

Dictionary             Auto shapes             Different fonts               

Drawing                Different colours      Bold 

Underline              italics                         Mail merge 

Spell checking       Formatting               Designing tables 

Inserting clip art and images  

Database 

 

A database is a collection of data put together to put records together.  
This information is vital to the smooth running of an organisation.  When 
you use a database information is made available at your fingertips. 

 

Databases can also be used to form reports that can be standardised to 
meet the needs of the organisation.  Examples of databases that your 
organisation has are: 

 Personnel systems 

 Client and contact management  

 Inventory control 

 Accident/incident reporting 

Email and 
internet programs 

 

There are many email software packages, like Outlook Express and 
Microsoft Office that you can use to send emails to clients, staff and 
management.   

There are many email software programs.  Examples of components are 
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Software What you can do with the software 

email software programs include: 

 Journals  

 Tasks 

 Contacts 

 Calendars 

 Send emails 

 

If you are not familiar with the communication software, hardware and devices, you should take steps 
to learn how to use it.  Most software packages will come with help and written manuals.  Hardware will 
usually have a user’s instructor guide or a user manual.  These manuals are designed to teach you how 
to use the equipment. 

If you do not know how to use the hardware, software and/or software packages, you should take the 
time to learn how to use them correctly.  This will increase your productivity and will make your job 
easier. 

When you use any of these devices or packages to communicate with the required parties, you need 
to make sure that you communicate in the way that the party indicated.  For example: 

 A manager who is always on the run will not have time to stop and talk to you.  The 
manager will want to thoroughly read a report and then make an appointment to see 
you if she or he has any questions.  In this case, the manager may prefer to receive an 
email. 

 Conversely, a client may prefer to receive a telephone call.  The client may prefer the 
personal touch and they like to talk to you.  If you send an email, they may in some 
instances ignore it.   

1.4 - Determine requirements of documents 
 

Before you write a document, take the time to find out what the 
requirements are before you start.  Research how the document 
was developed and what the document was used for.  What 
writing style was used to develop the document?  Are the 
expectations of the document different now? 
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There are times when you are required to develop a document in response to the needs of a new end-
user.  Use the following methods to develop the document and determine the requirements of 
documents already established. 

When you gather information, consult with the recipient to determine what they require.  This could 
mean the end-user, customer or developer.  Some of the information that you may require, includes: 

 Who the target audience is 

 Have an idea of what you are trying to achieve 

 Describe the features of the document and what the document needs to achieve. 

 Ask the end-user what they need the document for 

As you learn the requirements of a document, take the time to gather the information by recording it.   
Basic information you should collect includes: 

 The title 

 Detailed description of what is needed 

 Who recorded the information 

 The source of the information 

 Why is this information necessary 

 Who will be impacted by the required 

 What are the priorities of the document, according to your source 

Classify the information into: 

 What you are trying to achieve and the impact the document may have on other 
stakeholders 

 What needs to be addressed or what is not really needed 

 How to handle the issue 

 What the assumptions of the document are and how to confirm assumptions. 

Prioritise the information and negotiate as required.  Each requirement 
should be balanced according to the: 

 Desired outcome 

 Stakeholders that are going to receive the document 
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 Costs 

 How the document is going to be developed 

 Whether the requirements of the document are clearly understood. 

When documents are developed, you should include: 

1. Introduction - Discuss the purpose of the document and what it should be used for.  Clearly 
state the background of the topic and provide information to support the purpose of the 
document so that it is understood. What are the boundaries and expectations of the document?  
Emphasise any issues that need specific attention. 

2. Body - The body of the document needs to reflect the introduction.  If you are writing a report 
on safety issues, you may address areas of concern and then cite aspects of the law to support 
the reason why the issue is important.  Discuss viable options – Both the positive and negative 
aspects of the issue.  Explain constraints and list any assumptions that are made.  

3. Conclusion - Draw conclusions from your findings. 

4. Recommendations - From your findings draw recommendations.  These recommendations must 
be based on facts taken from the body of the document. 

The format of a document will change based on its requirements.  For example, if you are writing a 
brochure, use the same process for finding out information.  You may even perform a comparative 
analysis, but you will not need to draw conclusions.  In brochures, the role of the writer is to provide 
sufficient information to ensure that the recipient can make a decision. 

Care should be taken to ensure that all legislative requirements are reviewed to ensure that you meet 
your legal obligations under the law.  These requirements will usually include: 

 Making sure that all safety requirements are met 

 Ensuring that all information is factual and not based on conjecture.  You could be in 
breach of the sale of goods Act and the Trade Practices Act. 
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1.5 - Determine categories and logical sequences of data, information and 
knowledge to achieve document objectives 
 

Sequencing refers to the flow of information throughout the document.  Think of the time that you 
received a document and then spent a couple of hours trying to understand the message being 
conveyed.  The message did not flow together.  Instead the writer would make a recommendation but 
would not support their recommendation until three pages later.   

How frustrated did you get with them?  When you write a document, 
you need to not only consider that structure of the document, you also 
need to consider if the document is easy to read and that it flows 
together. 

The sequencing and structure will be enhanced when you asking 
yourself the following questions.  They are: 

 Are there any inconsistencies in the font type including 
the headings and captions that you included in the 
document? 

Also make sure that the artwork and graphics flow together by making sure that you: 

 Proof read artwork and captions to make sure that words are spelt correctly with them 

 Check that the spacing is consistent 

 Ensure sure that text font is consistent across the different headlines 

The way you present information to a reader, should not only hold their interest but be another way in 
which to emphasise important issues and suppress the unnecessary.  Information can be presented in 
many different ways, and these include: 

Categories and logical sequences of data, information and knowledge may include: 

Arguments and rebuttals 
Arguments and rebuttals are arguments for and against.  These documents are where the author 
provides both sides of an issue.  For example, you have been assigned the task of purchasing equipment 
for the organisation.  After researching the information and comparing it against the organisations 
requirements and the specifications that fit the replacement model, you must give both the positive and 
negative facts in regards to the product. 

Be objective and make sure that the facts are correct.  When decisions are made based on these facts, 
you may cost your organisation a lot of money.  
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Categories and sequences traditionally used for the particular type of document being prepared 

How was the original document written?  Traditional sequences and categories can be found in 
controlled versions of the document templates or through historical data.  What are the established 
ways in which information is presented in the organisation? 

Some organisations do not have set procedures so you may need to either: 

 Identify the correct template used to write the document 

 Access information archives to find out how the document was written and presented.  
If you are lucky, the original writer of the document may have also maintained a record 
of how the document was written and the methods used to collect and present 
information 

Chronological, alphabetical or operating sequences 
These types of sequencing starts with presenting information in order from one point to another.  
Chronological order and alphabetical order is the appropriate order of date and numbers.  Operating 
sequences refers to the sequences according to the assembly and correct usage of a product. 

For example: 

Chronological Alphabetical Operating 

01.02.2012 

02.02.2012 

03.02.2012 

04.02.2012 

a. 

b. 

c. 

d. 

1. Press start button 

2. Enter User Name 

3. Enter Pass Word 

4. Press Enter 

Facts, observations, conclusions and recommendations 
In each instance, when you write each of the above, it is essential that you use reference material to 
support your information.  This means that when you make an observation, you should write what you 
see and the possible reasons for what is occurring.  For example; workers were observed to not be 
happy with the way in which the problem was resolved.  Every worker was very vocal in voicing their 
concerns and the lack of respect management has for the workers opinions. 

Facts may include the specifications for a product.  They are used to demonstrate that the product 
meets the organisations requirements.  Slight variations in areas such as measurement, quality and price 
can influence the decision being made. 
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Conclusions are summations of document and provided a series of statements based on the findings of 
the document. 

Recommendations and supporting arguments 
Recommendations are derived from an analysis of the information taken from the document.  They can 
include a recommendation and a series of references to support your argument.  Supporting arguments 
can be results of case studies from other work environments, results from scientific research reports, 
either descriptive or statistical in form. 

Illustrative case studies and other examples 
Illustrative case studies and examples are used to clarify the intent of the information that you are trying 
to convey.  Illustrative case studies serve to make an unfamiliar scenario, familiar and to give the reader 
a common language about the topic in question. 

For example, when we discuss categories of sequence, we consider the shopping lists that we make up 
each week.  When you are a full time student and on a tight budget, food shopping lists are usually 
prioritised in order of what you must have, should have and could have, so that the student purchases 
the items they must purchase to live. 

Linking and summary statements 
A summary statement is a statement summarising the full document.  For example, a summary 
statement about this learning guide could be:  This learner guide provides you with a step by step guide 
into introducing, writing, referencing, ordering, drafting, concluding and finalising the development of 
writing complex documents. 

A linking statement is simply a sentence that ties up the end of the paragraph reminding readers on how 
a topic fits into the topic at the start of the document.  For example: As you can see this product clearly 
demonstrates that it has the specifications and operational functions to meet production requirements. 

The categories and sequential requirements of a document should clearly align with the requirements of 
the document.  Like the rest of the document, all arguments, recommendations and conclusions must 
link together to form valid and reliable information that supports the requirements of your document. 

1.6 - Develop overview of structure and content of documents 
 

The structure of a document and the content of documents are linked together using tags.  Headings, 
illustrations, appendices and tables can be shown in the table of contents.  If the document is still in an 
electronic format you can click on the table of contents item and press control and the word processing 
program will send you to the Heading within the document. 

If updated correctly in printed format, you will be able to identify where the heading or item can be 
found within the document. 
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Structure 
The structure is the way in which a written document is formatted.  Not all written records have the 
same structure.  For example, the conventions of most letters will vary according to the type of letter 
and who the recipient is.  Refer to Appendix Number Two and look at the formatting of the different 
letter formats in the templates.  Notice that the positioning of the name and address, and the 
formatting differs.  This is the structure of the document. 

Document structure also includes not only the formatting, but the way in which information is 
represented when you put it together.   

A good structure includes: 

1. A solid introduction about what the purpose of the document is 

2. Make sure that everything ties together 

3. Organise material so that it flows together  

4. Pull the reader in with clear, succinct information, correct use of white space, visual 

presentations and diagrams 

5. Look through your research and identify if you have identified all of the appropriate topics 

6. Use conclusions that are a logical sequence of everything that you have done before 

7. Draw recommendations in a logical sequence and support your recommendations with 

appropriate references 

8. Proof read and check against organisational requirements before you process 

Table of contents 
Information in a document is then marked up with indicators called tags so that you can find 
information in the document within a table of contents. 

A table of contents must be laid out so that readers can navigate through a document to obtain the 
information that they require.  A table of content can be a long term process.  However word processing 
programs make designing a table of contents a time saving process. 

To open a table of contents: 

1. Left click on references in Word 
Document 
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2. Move left to table of contents and point to Table of Contents 

3. Click Table of Contents and the task 
pane will drop down. 

4. Choose a table of contents and left 
click 

Set a table of contents where you would like 
it to be presented.  Table of contents should 
appear after the title page and before the 
Introduction. 
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To control the Table of Contents, you can determine the Level of Heading that a Heading shall have.  
To control the Table of Contents:  

1. Left click on Add text in the Table of Contents 

toolbar. 

2. The task pane drops and choose the Level of Heading 

3. Left click.  You have now tagged the structure to the 

table of contents. 

To include the Table of Contents, merely 

1. Left click on Update Table 

2. A second task pane will appear  

3. Choose update page numbers only or update entire table 

 

 

 

 

 

 

 

  



P a g e  | 38 
 

2. Draft text 
2.1 - Review and organise available data, information and knowledge according 
to proposed structure and content 

2.2 - Ensure data, information and knowledge is aggregated, interpreted and 
summarised to prepare text that satisfies document purposes and objectives 
 

Organise information, data and knowledge into a proposed structure.  Before you write a document, 
care should be taken to make sure that you put the information into an order that will reflect the flow of 
information that you are going to follow. 

Review and organise data in the following order: 

Familiarise yourself with the information and data.  Note how the information is relevant to the purpose 
of the document and compare it to the organisational requirements.  Make sure that your document is 
within the organisational requirements as well. 

Identify patterns in the data and cluster information 
together.  When information overlaps, you may try 
taking a copy of the information and highlighting it so 
you will find the main points easier to find when you 
require using them.  (Remember your organisations 
policy on recycling and use the back of recycled paper 
when you take copies of the paperwork you are going 
to copy). 

Identify patterns in the data and cluster them together.  What pattern makes sense?  How will you use 
the data?  For example if you are performing a comparative analysis you may present information with 
the name of each brand, discuss the positives and the negatives of each brand in order using one 
paragraph to discuss both.  Conversely, you may use specifications and format the information into a 
table. 

Set up categories alphabetically so you can determine what the main categories are.  For example, 
sorting information into online or offline information. 

Sort the data into a logical sequence.  Put data together and organise and sort it into appropriate folders 
ready for you to write the document. 

Once information has been sorted, write the first draft of the document.  Make sure that you keep focus 
on the purpose of the document, legislative and organisational requirements that will impact on the 
document. 
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Interpret 
Information may be interpreted in many ways.  The priority of the way in which the information is 
interpreted will depend on the priorities set by the organisation.  For example, emphasis on a choice of 
product may be based on price.  Conversely the priority is based on the level of safety and then the 
consideration of price.  Remember that when performing risk assessments, it is important to identify all 
of the levels of risk control for the hazard. 

When this information is identified, then the budget allocated will influence which control measure will 
be put in place to minimise or eliminate the risk.  This is where you should consider the organisational 
requirements as they should influence the way information is presented. 

When you start interpreting information, make sure that you: 

 Always start with a review of your goals, the reason 
why you are writing this document.  This will assist 
in how you present the data.  If you want people to 
fully understand how the document or purpose 
works, you could organise information into 
chronological order so that the reader can go 
through the data.  If you are going to categorise 
data, categorise it according to the measure that will 
be used to evaluate the results. 

 Attempt to put all of the information together and compare results from expected or 
promised or against other similar products that align with the goals of the document 

 Consider worker recommendations to improve and discuss them in alignment with your 
break down of the information. 

 Record conclusions and recommendations in the document and associate the 
interpretations to justify your results. 

Summarise 
To summarise is to say the same thing in few words.  We are inundated with information all day every 
day.  The aim of summarising is to read a longer document and to break it down into its main points. Try 
to summarise in your own words and write sufficient amounts to ensure that the information provided 
is sufficient for the recipient.   
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Aggregate 
When you aggregate information, you need to consider all of 
the information that you have put together so it flows together.  
Aggregate refers to the groupings of information and: 

 Its logical sequence 

 Headings and sub headings and how they 
relate to the purpose 

 Objectivity of the information – your role is to 
provide facts and allow others to form 
answers.  You should not influence a business 
document in any way.  Even your 
recommendations should be based on facts, 
not on personal preferences.  All 
recommendations must therefore be supported with recognised references 

 Order and flow of the text and use of graphics (see Section 2.3 of this Learner Guide) 

 Conclusions 

 Recommendations. 

All of the information must flow together and be understood by the intended audience. 

Avoid some of the pitfall of writing, which may include: 

1. Providing too much information 

2. Rely solely on questionnaires to capture to full purpose 

3. Interviewing for success. 

Throwing away research results once the final document is generated. Results do not take up much 
room and can provide more information in the future when it is needed. 

2.3 - Include graphics as appropriate 
People understand information in different ways and presenting information in different formats will 
assist them in understanding information.  For example, graphics can tell different stories by presenting 
trends, comparisons, geographic and technical data. 

When using graphics you should ask the following questions: 

 What is the purpose of the report? 

 Who is the audience? 



P a g e  | 41 
 

 What are the key messages for the audience? 

When you present data using graphics, remember three rules and they are to: 

1. Keep it simple 

2. What does the graphic need to communicate? 

3. Not assume that people will read the text that accompanies the graphic. 

You are working in a work place where many staff have English as a second language.  You have 
responsibility to provide them with not just tables and works, but with graphics and other visuals that 
will clarify and can be used to reinforce the point that management is trying to convey.  Different types 
of inclusions can be applied through illustrations on the Insert Tab in a work document 

 

To open each icon within the illustrations section of the insert on the Microsoft 2010, you need to 
open Microsoft Word: 

1. Move the cursor to Insert 

2. Left Click and the toolbar will change 

3. Move the cursor to illustrations; and write click  

Before you use any illustration features, make sure that you 

follow the first three steps above. 

ClipArt 
1. Click 

2. The task pane Clip Art will appear on the right side of the 
screen. 

3. Enter the Clip Art that you would like in Search for 
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4. Once you have chosen a Clip Art that you believe will suit your purposes, click on it once and it 
will open on  

 

Picture 
1. Click  

2. Double Click and Pictures folder 
opens 

3. Double left click on appropriate 
file and it will open 

4. Right click picture and it will 
appear on the document that you have open 
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Charts 
 

1. Click 

2. The task pane Insert Chart will open on 
the screen 

3. Choose a chart and click on it. 

4. Click ok 

5. The task pane will open as shown below 
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SmartArt 
1. Click 

2. The upper task pane, choose a Smart 
Art Graphic will appear.   

3. Click on the graphic that you would like 
to use and the graph art such as the 
text will appear. 

 

 

 

Shapes 
1. Click 

2. This task pane will appear on your screen 

3. Choose the shape that you prefer ; and 

4. Click on it  
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Practice using each of these icons in your documents as part of improving your written communication 

skills.  If you would like to learn more about these formatting processes, refer to  on the upper right 
hand corner of the Word Document. 

Use the Search parameter 
to provide you with 
information about how the 
package works.  The 
program can be obtained 
on and off line.  

If you are a learner who 
learns better with 
instruction rather than 
reading make sure that 
you are connected to the 
internet and you will be 
able to download video 
instruction on how to use 
the function within the 
program.   
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Common graphics can be used in the following circumstances: 
 When to use 

Bar chart Good for comparisons 

Easy to construct 

Illustration Shows technical and geographic data 

Can show a lot of information in a small space 

Line graph Good for showing trends 

Good for showing the differences between groups 

Photograph Capture a picture to assist them in providing a picture of what is          
happening 

Pie Chart Good for showing perceptions 

 

After you have created the graphic, ensure that: 

 It is easy to understand 

 That the information is easy to interpret if the audience is not familiar with the 
information is unfamiliar to them 

 That there is sufficient white space around the graphic 

 Whether the information is relevant to the text of the document 

2.4 - Identify gaps in required data and information and collect additional 
material from relevant enterprise personnel 
It is only when you are writing a draft of a document that you may become aware of information that 
you may be required to add additional information or data to the document that you believe is relevant 
to support you or reinforce other information or facts. 

When adding information, ensure that it is relevant 
to the parties that it involves.   Whenever you write 
a document, it is essential that you maintain the 
standards set by the organisation, legislative and 
regulative requirements and as the code of practice 
and privacy laws.  
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Breaching any of the legislative and regulative requirements can leave you open to fines and in some 
cases jail term.  Remember it is also essential to follow your duty of care to ensure that your workgroup 
members confidential information is not accidently passed on in the communication.  In fact, remember 
that unless the worker has given their permission, you are not legally allowed to let anyone recognise 
them under confidentiality laws. 

When you identify a need for information, it is important that you identify  

 The source of the information 

 Whether you are required to consult with people internal or external to the 
organization 

 Whether you have access to the information  

 The relevance of the information 

 Whether you are required to obtain permission to provide the recipients with the 
information required. 

If you are still learning to communicate with personnel in writing and you are consulting with a member 
of staff who may be operating as a mentor, trainer or coach, take the time to review the document with 
them.  Their experience will assist you in ensuring that the quality of your work adheres to 
organisational standards.  If you do not have the advantages of another person who you can consult 
with, then check your organisation’s historical records to determine whether the information that you 
gathered is relevant and to check that the tone of the letter matches the tone that you have used. 

2.5 - Draft text according to document requirements and genre 
When a document is designed, it needs to appeal and attract its audience.  If you know who the 
organisation’s audience is, then you should be able to ensure that the templates obtain and retain the 
interest of the audience.  Documents should be geared towards: 

 Simplicity – Make sure that the document is short and 
straight to the point.  Avoid using verbose words that the 
reader does not understand.  They will quickly grow bored 
with the document and stop reading it. 

 Diversity – The tone of a simple document can be changed 
by the words that you use.  For example, instead of writing 
that “the product is bad,” you could write that “even though 
the customer did not like the product, a surprising interest 
was found by another target group.”  This stimulates the 
readers and encourages them into reading the rest of the 
document 

 Balance – Documents should be balanced in two ways.  They include: 
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1. If you choose a picture on one side of the page, do not leave the area next to it 
white.  The audience will become confused.  Write about the picture by writing 
next to it and explain what the picture is about. 

2. Words can also be used to balance a document.  There will be some documents 
that you will expect to have verbose words in it.  To stop the audience from 
going to sleep when they read the document, use words that will maintain their 
attention. 

 Relative positioning of headings and graphics - Headings should be clear and simple.  
They should ensure that the audience knows what you are trying to tell them.  The 
graphics used to convey information should relate clearly with the heading.  A graphic 
that does not relate to the heading can confuse the audience. 

 Typography –Typography includes the font that is used for the document.  The most 
common forms of font are Times New Roman or Arial.  When a font is chosen it needs 
to be legible.  Small print or capital letters are hard to read.  The audience may become 
bored reading the font in long documents. 

 Text flow – Text should flow together.  Use headings as a guide to control the 
document.  Disjointed words and sentences that change topic all of the time can 
confuse the audience.  To avoid confusion: 

o Use one topic per paragraph 

When you write the document, it is important that you remember: 

 Who the audience is 

 The purpose of the document 

 How would you format the letter? 

 What structure would you use? 

 How would you use key points? 

 What are the organisational requirements that you would need to consider? 

 What method of communication would you use? 

 What package would you use to communicate the 
message? 

The way in which you structure and design the layout of your text 
documents should be a reflection of your audience.   Make sure 
that the text is kept short and simple, taking care to ensure that: 
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 The page layout is consistent through the whole document.  For instance, indented 
paragraphs should be used throughout the whole document 

 White space is used to make the document more attractive and easier to read, by giving 
the reader time to pause and think about what they have read 

 Typeface is used to make the document more attractive.  For example, changing the 
colour of text or changing it to bold without making it look too busy. 

 Graphics, photographs, clipart and drawings are used to prove a point 

 Boxes are used to make points next to graphs and to add colour to the document 

 Colour is used to highlight shape or main points. 

 Headings are short and succinct telling the reader what is in the section below; and 

 Columns are used to make lists of items. 

The purpose of drafting a communication, especially when you do not have much experience and are 
not familiar with the legislation in the communication, care should be taken to ensure that no part of 
the communication is incorrect.  Many supervisors and managers can lose their credibility if they do not 
adhere to organisational conventions and make sure that the facts in their communications are correct.   

In the same way, as a worker you can also place yourself at risk by providing insufficient data where 
individuals make decisions.  Those decisions can be high not only for the organisation as a whole not 
only financially, but also for their credibility and reputation.  On a personal level, you could also lose 
your reputation if you do not ensure that you do a draft and then follow it up by proofreading the 
document. 

Templates and house styles are two ways in which you can obtain assistance in your graphics and art.  
You may also need assistance in writing the draft.  You will always find words that are hard to spell or 
you are not sure about.  A dictionary can assist in spelling and can define a word so you can identify 
whether the word is appropriate for the subject matter. 

There may also be times when you may know a word, but do not think that the word is appropriate.  
Refer to a thesaurus.  A thesaurus will provide you with all of the nouns, adjectives and verbs that you 
need.  The thesaurus will allow you to look up a word and then will list words that are similar to it.  If you 
are unsure about a word, look it up in the dictionary. 

2.6 - Use language appropriate to the audience 
Visual graphics can assist you in communicating with personnel that have English as a second language.  
However, over the period of your professional life, you will be required to communicate at all levels of 
the organisation.   
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If you do not use language appropriate to the audience, you will not be able to obtain appropriate 
feedback.  The feedback provided by your workgroup could influence your final decision.  If they have 
not understood all of the information that they have received and you make decisions based on 
incorrect feedback, then your decision may not be informed.  

When this information extends to uninformed work health and safety decisions, you could be found to 
have breached your duty of care. 

The audience is the person who you are writing to.  The audience may include: 

Internal and external customers 
An internal customer is someone who works for the organisation.  
This is your manager, your supervisor and your workgroup.  An 
external customer is anyone who does not work for your 
organisation.  This includes your supplier, any WHS consultants or 
specialists who are going to assist you or run an investigation with 
a hazard or risk in the work place.   

This also includes the inspector who may be allocated by your 
State/Territory Regulator to investigate an accident or incident in 
your workplace.  A customer is someone who enters your 
workplace.  They may not buy anything, but they observe your 
operations and form opinions about your operations and your 
product.   

Recipient/s who receive a copy for information 
There will also be times in which you will need to send information to more than one person; For 
example, when you send an email to an external customer (Appendix Number One). 

Anyone who requests a copy of the report or information will be CC which means carbon copy.   

There is also an option to send the information to someone who does not want others to know that they 
received the information.  This is BCC which means blind carbon copy.   

When a recipient asks for a copy of an email, make sure that they are allowed to have that access to the 
information. 

Primary recipient/s of the communication 
The primary recipient is the main person who the communication is to.  When you send information, it 
is essential that you communicate in the manner that they prefer.  The primary recipient is the one that 
must receive the information. 

This means that when you send a communication or communicate information you must consider the 
purpose of the communication and how they would like or need the information communicated. 
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3. Prepare final text 
 

3.1 - Review draft text to ensure document objectives are achieved and 
requirements are met 

3.2 - Check grammar, spelling and style for accuracy and punctuation 
 

Flatter hierarchies’ in organisations means that the formal roles of managers have evolved and more 
and more workers are becoming involved in writing business documents.  As such, the review of 
documents is becoming more and more important 

There are three steps that you should follow when you review a document.  They include: 

1. Read the document to see if it makes sense 

When you think, you think faster than your fingers 
can type.  As a result of this, words, phrases and 
ideas may be missed.   

Make sure that all of the objectives have been 
reached and supported.  This means that each 
time a finding or observation is made; it must be 
supported with facts that argue both sides of any 
argument. It is only through considering both 
sides of an argument that you can have an 
objective evaluation of the purpose of the document.  Make sure that: 

A. You check that all points are supported 

B. That no part of the document will influence an answer. 

C. Make sure that all ideas are followed through to the end. 

 

2. Examine the structure of the document 

Make sure that sections are placed appropriately. If you feel that the argument does 
not flow smoothly, then you need to make sure that you review the order of the 
arguments to make sure that they flow together in the appropriate order. 
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Are your headings specific?  Do they assist in letting you know where the document is 
going?  Readers should be able to look at the headings and sub-headings and know 
where the writer is going with their document. 

3. Check for inconsistencies in details 

Inconsistencies can arise in many instances.  You type faster than you think so spelling 
errors can arise that the computer’s spell check does not automatically pick up.  
Inconsistencies may arise in: 

 Grammar 

o Grammar is the way in which the English language 
is structured.  There are two types of grammar: 

 Descriptive grammer is the way in which 
we actually talk and write.  Descriptive 
grammar relies on the patterns that 
underlie our use of words, phrases, 
clauses and sentences 

 Prescriptive grammer is the structure in 
which specific people feel it should be.  
Prescriptive grammar relies on what people believe are the correct and 
incorrect use of language. 

To practice your grammar, go to Learn 4 good Website at 
http://www.learn4good.com/languages/evr_english_grammar.htm Access Date: 
15.01.12 

 Spelling 

When checking your spelling, you can access Spell Check on Microsoft Office.  However, 
it is important to note that the spell checker has a reputation for not being able to 
deliver 100% of the time as errors can still be found after you have used it.  Readers can 
become irritated with inconsistencies in spelling , such as between American and 
Australian spelling. 

It is always good to read the document through once to identify irregularities in the 
spelling, font, text and numbers.  Proofreading grammar includes: 

o Remove jargon and slang from the document  

o Spelling irregularities 

http://www.learn4good.com/languages/evr_english_grammar.htm
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o Check the spelling of all names and the names of the business 

o Take care to check the numbers carefully.  In one instance, an organisation sent 
an email to its customer underquoting itself by $10, 000 when a member of the 
work group forgot to add an extra zero to the end of the document.  If 
calculations are being used make sure that the addition, subtraction or other 
math operations appear in text, doublecheck the figures.   

The failure to check spelling and grammar can lead to expensive errors if they are not 
caught on time.  Care should always be taken to double check all documents and care 
should be taken to make sure that the document goes to the correct recipients. 

 Check Style of Writing 

Make sure that you write in a consistent manner.  You should use the style of writing 
consistently throughout the full document.  Business documents must be professional 
at all times.  The business writing style may 
include: 

o Using short sentences (one sentence – 
one thought) 

o Use simpler sentence structures 

o Use an active voice 

o Write from the organisations point of 
view 

o Identify where you obtained 
information from, except where it is contrary to the Privacy Act 1988 and in 
contravention of section 271 of the WHS Act for legislative requirements – 
whereby the identity of a person remains confidential without their permission.  
If you use information from their files, no one should be able to identify who they 
are). 

o Recommend actions rather than individual beliefs 

o Avoid anything that provides you with self-doubt 

o Avoid self-references or references from others 

All of these areas should be checked to make sure that they comply with the 
organisations policies and procedures. 
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Check to make sure that all of your references are accurate.  Technical details and 
prices of products and services, including quotes should be included if they are relevant 
to the report.   

 Check punctuation 

Verbally read the document if necessary to determine whether your punctuation is 
correct.  If necessary, ask another member of your team to re-check your work. 

 

Meeting Needs 
Before proofing a document read it through first and re-check the layout.  It is not only important that 
the document is clear and concise.  The document needs to appeal to the recipient, encouraging them 
to read it.  The use of graphics and art, the sequencing and structure of the document should all appeal 
to the recipient.   

It is important to make sure that the language is 
appropriate, that the art and design of the document 
balances and that the content stimulates the end-user.  
Managers, clients and their representatives and any other 
people that you may communicate with usually receive a 
lot of emails, letters and other forms of communication 
every day. 

In most instances, people will usually choose the 
documentation  that appeals to them first.  If your document is clear and concise and appealing to look 
at and read, then it will most likely be one of the first that will be read.  When a document does not 
appeal to a person, they tend to put off reading the document until it is imperative that they do so. 

For example, you have booked a consultation meeting with your workgroup.  The message conveyed by 
the document is very important and you require feedback so that a final decision can be made in regards 
to the hazard.   

Legislative requirements 
While checking the draft, make sure that organisational requirements are met.  These requirements may 
include 

 Ensuring that you are not in breach of any discriminatory laws.  This means that you 
must check the wording to ensure that discriminatory words are not used.   Your 
organisation may have specific procedures that outline the words that should not be 
used. 
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 Ensuring that no breach in copyright or confidentiality laws are breached.  Check to 
make sure that if you are handling a work health and safety issue that the name of 
workers are not released and that they are not identifiable based on your document.  
Breach of this law will ensure a fine if the issue is escalated to a complaint to a work 
health and safety investigator. 

 That the organisations communication protocols are met.  Check to make sure that 
you have considered all protocols such as whether you have breached your level of 
authority or whether you are including information that should not be in the report.  
Remember the communication protocols are in place to control the flow of 
communication.  If you are not sure about information that you would like to include in 
the process, discuss it with your supervisor. 

Technical requirements 
Make sure that the technical requirements are correct.  
Entering a wrong price, amount of measurement can change 
the choice that a manager makes.  If you are quoting for a job, 
an extra zero or a zero less can change whether you win the 
contract or not and in turn can change the ongoing operations 
of the organisation. 

Organisational requirements 
Make sure that the organisational requirements are correct and appropriate.  This includes checking the 
formatting of the document, the way in which it is structured and the organisations procedures in 
regards to the visual presentations. 

3.3 - Ensure draft text is approved by relevant enterprise personnel 

3.4 - Process text amendments as required 
 

In the policies and procedures of writing documents, you will be advised who you will need to obtain 
authorisation from before you process the final draft of the document.   

Authorisation may be required from your supervisor for some 
decisions.  However, under Section 47 of the WHS Act, “A 
person conducting a business or undertaking must consult, so 
far as reasonably practicable, with workers who carry out work 
for the business or undertaking and who are (or are likely to be) 
directly affected by a health and safety matter. 

This duty recognises that workers input and participation in the 
decision-making process about work health and safety because 
they are familiar with the work area and can provide unique 
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ideas about the work area.  As such, it is important that you share information with your work group 
with information relevant to them about minimising or eliminating risk in the workplace. 

At the same time, you may be required to “consult, co-operate and co-ordinate activities with all other 
persons who have a duty in relation to the matter” (Section 48).  This means that you should also 
consult with other personnel who have the same duties on the work health and safety issue that you are 
working on.   

It is important to note that under the consultation process you do not have to include workgroup 
members or anyone impacted by the hazard in the final decision making process.  You do however; need 
to take their views into account.   

Under the Consultation process, you should also make sure that you address any concerns or questions 
that workers bring up within a certain time frame and offer feedback on any proposed options.  Workers 
must also be informed of the final decision and the course of action to be taken, as soon as possible.  
This feedback must be informative and explain the reasons of your decision (Work Health and Safety 
Consultation, Cooperation and Coordination Code of Practice, 2010, p.10). 

If you have to process the document for management, you can also use the final consultation process to 
clarify points, review decisions and discuss feedback with personnel.  For example, if you provide 
feedback about a reason why you did not follow a recommendation from personnel and a work group 
member pointed out a problem with your feedback, you will be given an opportunity to update your 
draft before you generate information. 

Some of the changes that you may need to make to your draft may include: 

 Identifying the information that needs to be changed 

 Add text 

 Delete text 

 Copy text 

 Move text 

 Change the style of your text. 

 Change the formatting of text. 

Identify text that you want to change 
To change text, you will need to either, delete it, format it or move it.  This means that you will need to 
identify the text that needs to be changed.  When you do, then you need to press select.  This is done by 
positioning the cursor. 

To position the cursor 
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1. Left click the mouse 

2. Use arrows on the keyboard to move around the screen 

3. Ctrl + arrow key moves one word left or right, or one paragraph up or down 

4. Home moves the cursor to the start of the line. End moves the cursor to the End of the line 

5. Ctrl-Home moves to the top of the document. Ctrl-End moves the document to the end of the 
document 

To select text 

1. Hold Shift key down.  Click where you want the selection to end 

2. Hold Shift key down.  Use any of the methods listed above to move around the screen  

3. Double-click to select a word 

4. Triple-click to select a sentence 

5. Ctrl-alt to select the whole document. 

Add text 

Use the keyboard or mouse to position the cursor where you want to add your text, then type.  If you 
select text, your typing will over-write the text that was selected 

Delete text 

Use cursor on keyboard or mouse to position the cursor.  Press the Delete key to delete the character in 
front of the cursor.  Press the Backspace key to delete the character behind the cursor.  To delete a lot 
of text, select the text and press the Delete key. 

Copy text from one place to another 

1. Select the text you want to move 

2. Choose Edit > Copy 

3. Use mouse on the keyboard to the position where you want to 
copy the text to. 

4. Choose Edit > Paste 

Move text from one place to another 

1. Select the text you want to move 

2. Choose Edit > Cut 



P a g e  | 58 
 

3. Use mouse on the keyboard to the position where you want to copy the text to. 

4. Choose Edit > Paste 

http://www.shaunakelly.com/word/concepts/edit-word-document.html 

4. Produce document 

4.1 - Choose basic design elements for 
documents appropriate to audience 
and purpose 

4.2 - Use word processing software to 
apply basic design elements to text 
 

Design elements are added to a document to grab the 
attention of the audience.  To design a document 
effectively, you are required to ensure that 
important information stands out. 

 

All of the following design elements will be found 
underneath the Home tab in Words Office 2010. 

Design elements found in font under the home tab 
include: 

Fonts  
A font is the style of writing used in the text.  Next 
to the choices of font, you are able to adjust the 
size of the text. 

If you look at the task box, you will be able to see 
that the current font is Calibri, Size 11. 

To change the Font: 
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1. Point the cursor at the arrow next to the font box and left click on the mouse. 

2. The task pane will drop.   

3. Move the cursor down the task pane and click on the appropriate font. 

If you want to change the font on certain text, highlight the text before you perform actions 1- 3. 

To change the colour of the font: 

1. Highlight the text you want to change the colour of 

2. Move the cursor to the colour box in font and point at the down 
arrow, left click 

3. The theme colour pane will drop.   

4. Point the cursor at the colour you want to change the font to 
and left click once 

 

Capitals  
To convert lowercase to uppercase you can use  in the Font on the Home Tab.  To change to capitals,  

1. Highlight the capitals that you want to change 

2. Move the cursor to the arrow next to the Aa and left click once. 

3. Choose how you would like to capitalise the letters, point the cursor 
at it and left click your mouse once. 

 

Underlining 
To underline text,  

1. Highlight the text that you want to underline 

2. Move the cursor to            left click and the words will be 
underlined.            

Change the thickness and colour of the underline by using this 
drop task pane, using the  
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Justification and alignment  
Under the Home tab, in Paragraph, right to the Font bar, you will 
find justification.  Justification is the alignment of text on a page. 

 

 

At this time, we are using left alignment. 

 

Now we are using right alignment. 

 

Now there is central alignment 

 

 

Lists  
Lists can be found under the Home Tab on Paragraph between 
Font and Styles.  Lists can be different bullet points.  Bullet points 
can be either numbers, alphabetical or symbols or a mixture of all 
three. 

To obtain bullet points,  

 Place the cursor where you want it to be on 
the page. 

 Left Click on the downward pointed arrow. 

 Move the cursor down to the appropriate 
bullet point 

 Left Click and a bullet point will appear. 

 Write your list.   

 Complete the list. 
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 Point the cursor at the list again.  

 Left click on the downward pointed arrow and 

 move cursor down to None 

 Left click. 

You will no longer receive any more bullet points. 

The following Styles are found in the Home Tab on the right hand side of the page. 

 

Headings 
The best way to add 
headings is to use styles.   

Quick Styles will give you 
heading styles already 
developed 

 

 

Paragraph 
indentation 
Paragraph indentation can be found under the Home Tab 

In paragraph in the Home Tab, you will find this icon 
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By Left Clicking this icon, you can adjust the indentations.  The arrow indicates the direction in which the 
arrow will indent.  Point the cursor with the arrow pointing right and the arrow will tab in five spaces 
when you left click it.   

Don’t like the look? 

Point the cursor with the arrow pointing left and the arrow will tab back in five space when you left click 
it. 

Tables  
Tables are an excellent way in which to present information.   
To open a table in a word document once a word document is 
opened, go to the Insert Tab and move down to the tables 
toolbar: 

 Move mouse and use the pointer on Insert. 

 Left click Insert and move cursor down to 
Table. 

 Left click cursor and this task pane shall 
appear. 

 

 

Tables can be designed in two ways: 

The first method is to move the cursor down the screen in the table.   

 Highlight the box in the drop down pane for the number of columns and rows you 
require.  Notice; that the number of lines and rows match those that are available on 
the document.   

 Once you have the correct number of rows and columns, left click your mouse.  
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The second method is to:  

 Perform the first 3 steps again 

 Move the cursor down the drop pane and left click 
where it is highlighted. 

 A new pane shall appear.  Enter the amount of 
columns and rows you require and left click on 
OK.  The table below shall appear. 
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Margins  
Margins can be found In the Page Layout Tab in Page Set. 

 

 

 

 

To catch the set up for Margins: 

1. Left Click the downward pointing arrow under the 
Margins tab 

2. Move the Cursor down the drop down task pane 

3. Left Click the appropriate Margin size 

 

 

Use and amount of white space 
White space gives breathing room for the eye and breaks up text 
from graphics.  White space can be added to make a page less cramped and confusing. 

Make sure that you do not leave too much white space.  Experience with writing and developing 
documents can assist if you feel that you have too much white space, especially if you are new to using 
desktop publishing.  Do not cram too much into a page, but ensure that you have enough space that 
important information does not get lost in all the text.  If you need to put graphics into a document, try 
a larger page. 

Create white space with 

 Headings 

 Margins 

 Line and paragraph spacing 

 Multiple columns 
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 Lists 

 Tabs or indents 

 Bullets & numbering 

The following basic formatting designs can be found in the following sections of the Learner guide 
including: 

Illustrations, photographs and other illustrative material for design purposes 

To use design graphics, refer to Section 2.3 of this learner guide 

Templates 

To access templates, go to Appendix Number Two. 

Logos, branding, organisational identity requirements 

To find out organisational requirements, including logos and colour schemes, refer to Section 1.2 of this 
Learner Guide 

4.3 - Check documents to ensure all requirements are met 
 

As you develop a document, add and subtract information which may impact on your original planning.  
To ensure that you have taken into consideration all of the original requirements of the document, 
review it. 

This means that you should ensure that you have: 

 

Met all of the document objectives        

Followed all of your organisations requirements       

Not breached any legislative requirements       

Chosen the appropriate means of communication      

Adhered to document requirements        

Maintained a logical sequence         

Reviewed and organised information into a logical format      

Made appropriate use of graphics        
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Identified and minimised gaps in information and data       

Drafted and reviewed document text         

Prepared final text – checked grammar and spelling       

Obtained appropriate personnel approval        

Processed text amendments          

Used appropriate software          

Checked document requirements to ensure that they were met     
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